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Abstract

SmaggIce (Surface Modeling and Grid Generation for
Iced Airfoils) is a software toolkit used in the process of
aerodynamic performance prediction of iced airfoils
with grid-based Computational Fluid Dynamics (CFD).
It includes tools for data probing, boundary smoothing,
domain decomposition, and structured grid generation
and refinement. SmaggIce provides the underlying
computations to perform these functions, a GUI
(Graphical User Interface) to control and interact with
those functions, and graphical displays of results. It is
being developed at NASA Glenn Research Center.
This paper discusses the overall design of SmaggIce as
well as what has been implemented in Phase 1. Phase 1
results provide two types of software tools: interactive
ice shape probing and interactive ice shape control.
The ice shape probing tools will provide aircraft icing
engineers and scientists with an interactive means to
measure the physical characteristics of ice shapes. On
the other hand, the ice shape control features of Smagg-
Ice will allow engineers to examine input geometry
data, correct or modify any deficiencies in the geome-
try, and perform controlled systematic smoothing to a
level that will make the CFD process manageable .

Introduction

Airfoil performance degradation due to ice can be
measured from aerodynamic tunnel testing. Two-
dimensional iced airfoil performance can also be pre-
dicted by  numerical simulation using CFD.  The use of

Copyright © 1999 by the American Institute of Aero-
nautics and Astronautics, Inc.  No copyright is asserted
in the United States under Title 17, U.S. Code. The U.S.
Government has a royalty-free license to exercise all
rights under the copyright claimed herein for Govern-
ment Purposes. All other rights are reserved by the
copyright owner.

CFD tools has demonstrated its potential as an efficient
low-cost means of predicting post-ice accretion aerody-
namic performance[1].  Ice accretion itself may be
obtained from either icing research tunnels, actual
flights, or an ice accretion prediction code such as
LEWICE[2].  Figure 1 shows the process of determining
iced airfoil performance from the iced airfoil geometry.
SmaggIce will support this process by providing tools
for measuring ice shape characteristics, preparing the
ice surface for gridding, defining and modifying the
flow domain, and generating the grid.

Trying to apply existing CFD tools to aircraft icing
problems with their characteristic highly irregular ice
shapes, which may include sharp corners and/or very
high curvature segments, has been a very difficult and
labor-intensive task for CFD engineers.  The study done
in reference 1 indicates that semi-automatic software
can improve the efficiency of this process, thereby im-
proving the usefulness of icing CFD.  Existing
structured grid generation tools could be either inade-
quate or very inefficient when applied to the rough
textured ice shapes found on iced airfoils. SmaggIce,
however, is specifically designed for iced airfoils. It has
special algorithms for parametric mapping, smoothing,
refinement, and explicit local and global grid control to
help create the quality grids that are required for com-
plicated ice shapes.  SmaggIce performs systematic
smoothing of ice shape data using control points[1]. It
will generate field grids using a control point formula-
tion[3] in a rectangular computational domain using a
parametric mapping technique[4].  Effectiveness of these
technologies were tested and demonstrated in an earlier
study[5].

Most iced aircraft wing problems are three-dimensional
problems.  However, full 3D CFD processing from 3D
geometry (i.e., 3D ice surface scanning/definition), to
grid generation, to flow simulation will remain very
difficult and computationally expensive in the foresee-
able future.  Thus, SmaggIce is being developed for 2D
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interactive icing CFD, which will complement wind
tunnel testing and/or flight experiments.

SmaggIce will generate multi-block structured grids,
rather than other grid topologies such as unstructured,
Cartesian, overset, or hybrid.  If the grid generation
aspect of CFD was the only concern, then grid tech-
nologies other than structured could have been selected
for the code.  However, the value of any component
technology must be weighed in terms of its contribution
to the entire process, which includes surface modeling,
grid generation, and Navier-Stokes simulation.  At pres-
ent, Navier-Stokes CFD is more efficient, mature, and
reliable on structured grids than on other types of grids.
Hence, structured grids will provide greater overall
benefit in terms of accuracy and efficiency with the
semi-automated geometry modeling and grid generation
process of SmaggIce.

SmaggIce is semi-automatic, i.e., some of its functions
are highly interactive, some require user input of pa-
rameters, and some are fully automatic.  Although fully
automatic processing is ultimately desired for all func-
tions, the combined interactive-automatic approach will
utilize human intelligence as well as the rapidly ad-
vancing computational/graphical capability of
computers.  Icing CFD needs the best attributes of both.
SmaggIce is being developed in planned phases in order
to make it available to the aircraft icing community at
the end of each phase, with the opportunity for feedback
at each phase.  Development in Phase 1 involved pro-
viding two types of software tools: interactive ice shape
probing and interactive ice shape control in preparation
for gridding.  Development in Phase 2 will provide for
domain decomposition and gridding, with tools appro-
priate for iced airfoils.  Phase 3 will tie SmaggIce with
the flow solver WIND[6], allowing for control and feed-
back between the two.

Phase 1 Details

Ice Shape Probing
Interactive ice shape probing is used in the process of
characterizing ice shapes.  Probing involves making
measurements of the data on the screen, recording those
measurements in a table, and saving them to a file.  Fig-
ure 2 shows the controls used during probing operations
and examples of measurements.

Once the boundary data is read in, the user may make
probing measurements.  These include: point location
(e.g., ice limits), distance between two points (e.g., ice
horn height or width), arc length (i.e., the distance along

the boundary between two points on that boundary),
angle between two lines (e.g., horn angle), and X/C ((x–
xLeadingEdge)/chordLength).  Location and distance
may be normalized by the chord length of a clean air-
foil.  The probe points can be selected by various
methods: the closest point to any object, the closest
point to the current object, the closest point to the refer-
ence object, or an arbitrary point in space.  Probing
information may be saved to a text file and a corre-
sponding graphics display can be saved in the following
image format: GIF, TIFF, and PPM.

Ice Shape Control
Interactive ice shape control is used to prepare the sur-
face for gridding.  The types of functions that can be
applied to surfaces are curve smoothing, discretization,
and reshaping.  Any subcurve (or the entire curve) of an
element can be selected for processing.  Systematic
smoothing of the iced boundaries in a controlled man-
ner is accomplished using the control point formulation
described in reference 3 and illustrated in references 1
and 5.  Users can control the level of smoothing by
choosing the number of control points in constructing
curves.  Curve discretization provides a means of in-
creasing/decreasing the number of points, distributing
the points by curvature, and controlling the uniformity
of their distribution.  In addition, hyperbolic tangent
stretching is provided.  Direct reshaping of the curve (to
perhaps correct obvious ice shape errors) is done by
dragging control points associated with the curve.
These control features of SmaggIce not only prepare the
ice surface for the grid-based CFD, but they also allow
users to correct any deficiencies (e.g., tangles, gaps, too
many or too few points) in the input data.  Figure 3
shows the controls used when modifying the curve us-
ing free form control.

Graphical User Interface

The SmaggIce GUI provides an easy and intuitive inter-
face for the user to interact with the data.   Because
SmaggIce is highly interactive, this user interface plays
a critical role.

The SmaggIce GUI consists of a primary Main Window
titled "SmaggIce" and other sub-windows.  The Smagg-
Ice Main Window (Figure 4) includes the following
distinctive areas: Menu Bar, Graphics Drawing Area,
View Manipulations, Information , Current Object
Info , and Graphics Window Mode.  In order to pres-
ent a consistent user interface, the GUI was designed to
support current features as well as ones that will be im-
plemented in future phases.
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The Menu Bar organizes the features of the applica-
tion.  There are nine menu items in the Menu Bar: File,
Edit, View, Probe, Boundary, Grid-CN, Grid-Direct,
Solution, and Help.  The File menu contains compo-
nents for performing actions on files, such as reading
data, saving data, and saving an image of the screen.
The Edit menu is used for performing actions on the
current data of the application (such as “Clear All”).
The View Menu contains components for changing the
user’s view of the data.  The Probe menu allows the
user to measure ice shape characteristics, designate an
object to be the reference airfoil, highlight the reference
airfoil, and display probing markers.  The Boundary
menu allows subcurve selection and modification, in-
cluding discretizing and smoothing boundaries of
objects.  The Grid-CN and Grid-Direct menus will al-
low the user to perform grid generation and
modification.  The Solution menu will allow the user to
read in and display solution data that is associated with
a grid.  The Help menu allows the user to access docu-
mentation and hint information.

The Graphics Drawing Area is where geometry is
displayed and direct interactive manipulation of the
geometry is performed.

The View Manipulation  area contains six icon push-
buttons and the arrow icons, which modify the view of
the geometry without changing the data itself.  The first
set of buttons (Translate, Scale, and Area Zoom) set
active mouse modes so that mouse button presses and
movements modify the view continuously.  The second
set of buttons (Full View, Zoom In, and Zoom Out) and
the arrow buttons labeled Translate change the view
immediately when you press one of them.

The Information  area is in the left-hand side of the
Main Window.  While the user interacts with the
graphics window, relevant information is displayed in
this scrollable text area.  For example, while probing,
the coordinates of points are displayed here before be-
ing recorded.  As another example, when a subcurve is
being selected, information about the subcurve end-
points and the number of points in the subcurve is
displayed here.

Because there may be multiple objects, there is a con-
cept of a current object, to which functions may be
applied.  SmaggIce provides a mechanism to switch to
another object, setting that as the current object.  The
Current Object Info area displays information about
the current object such as: the type of object, its index

number, the number of points, and a diagram indicating
the object type.

The Graphics Window Mode displays the current
mode along with instructions.  Depending on the mode,
mouse movements and button clicks will have different
effects.

Implementation Issues

SmaggIce is written in FORTRAN and C.  FORTRAN
is used for the computational routines; C is used for the
GUI, control, interaction, graphics, and memory man-
agement.  It is intended to run on any UNIX platform
and has been tested on SGI, Sun, IBM RS6000, and HP
systems.  The GUI was developed for X-windows, using
Motif, Xt Intrinsics, and Xlib functions.  This will aid in
the portability of the user interface across multiple
computer platforms running X. OpenGL is used for the
graphics drawing.  It uses the GLX extensions to X to
interface with the windowing system, but the Mesa li-
brary[7] can be used if the workstation does not have
OpenGL or if the X server does not support the GLX
extensions.

Dynamic memory management is used to allocate only
as much memory as is necessary for data storage and
access.  This allows the same executable to process
smaller models on machines with less memory, and
larger models on machines with more memory.  It also
allows multiple input files to be read in and processed
during a single session.  In addition, when data is no
longer needed during a session, it can be cleared to al-
low for reading in new data.  Figure 5 shows the data
structures that make use of dynamic memory in Phase 1
of SmaggIce.  As objects are read in, memory is allo-
cated for them to store the object type as well as
attributes describing the object.  Space is also allocated
for the data points defining the geometry, and a pointer
stored with the object.  When additional objects are
read in, or as geometry is modified (e.g., points are
added), memory is reallocated as needed.  When objects
are deleted, the memory is freed to make room for new
objects.

Error checking is performed at all levels, starting at the
GUI, when the user enters parameters.  Any errors such
as out-of-range data or invalid values are immediately
reported so that the user can correct them.

The SmaggIce GUI is designed to provide “directed
control” or “guided use”.  This means that the user will
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be prevented, through the desensitization of widgets
(menus, buttons, sliders, etc.), from selecting conflicting
functions or functions that are invalid in certain
situations.

Role in Icing Effects Prediction

SmaggIce deals with three main types of objects: ele-
ments, blocks, and grids.  An element is either the entire
or partial boundary geometry of a solid or a section of
flow domain.  For example, an element may be a clean
or iced airfoil, or an isolated ice shape between upper
and lower ice limits.  Elements are typically processed
in preparation for gridding to correct input errors,
smooth the boundary, increase or decrease the number
of points, and/or redistribute the existing points as dis-
cussed in the “Ice Shape Control Features” section
above.  In figure 3, a smooth curve without any sharp
corners was constructed using the control point formula
that was presented in reference 3 and used in the task of
reference 1.  The shape of the smooth curve in bold is
guided by the piecewise linear curve that is formed by
the control points denoted in diamonds.  The number of
control points determines the level of smoothing.  All
these processes can be applied to any given element
using SmaggIce 1.0.

Once the iced airfoil boundary is prepared, the compu-
tational flow domain will be defined interactively
through a dialogue box in which the user can specify
upstream, downstream, upper, and lower boundaries in
terms of multiples of the chord length.  Domain decom-
position will be performed by an automatic process with
an option to use an interactive capability.  Further
blocking, merging blocks, or changing internal block
boundary shapes using control points can be interac-
tively performed, if desired.  Perimeter discretization
will be performed automatically, but the interactive
process will allow users to re-discretize or redistribute
points.

Quality grids require smoothness, orthogonality, and a
proper resolution for viscous flow computation. With a
clean airfoil, one can easily generate grids to meet these
requirements. However, when ice is present, these
requirements may conflict with one another. The diffi-
culty of generating a quality grid with ice is illustrated
using relatively simple ice shapes in figure 6. SmaggIce
will utilize grid generation and quality control tech-
niques that will provide quality viscous grids for iced
airfoils.  In particular, the control point form of

algebraic grid generation in SmaggIce will provide ex-
plicit local grid control capability without any global
effects as illustrated in figure 7. This shows that trans-
lation of a control point changes the grid only in a local
region around the translated control point.  When ice
shapes are more challenging, with horns and cavities,
the domain can be interactively divided into blocks as
shown in figure 8.  The flow solver WIND, described in
reference 6, runs on such a blocked grid.

Grids may be modified either directly by stretching,
smoothing, refining, and/or indirectly by moving points
of the control net.  Associated initial solution data can
be read and displayed underneath the grid to guide the
interactive improvement of grid quality. After grid
changes are made, the solution can be re-interpolated to
the modified grid.

File formats are defined for each of the entity types
(elements, blocks, and grids), so that as modifications
are made to them, they may be written to a file and later
read back into SmaggIce or into another grid generation
package.

SmaggIce is being developed for the overall process
displayed in figure 9.  The value of any technology
component will constantly be weighed against its con-
tribution to the overall process from iced geometry to
aerodynamic solution.  The SmaggIce code will be
closely tied to WIND[6], a flow solver that is supported
by the NPARC Alliance.  SmaggIce will prepare and
submit the WIND job, monitor its convergence, and
evaluate the results.  It is intended to become a software
tool that will streamline the whole process shown in
figure 2.

Status and Plans

Phase 1
Phase 1, which includes interactive ice shape probing
and interactive ice shape control, is being released as
SmaggIce version 1.0.  The Alpha version was made
available to aircraft icing engineers and researchers at
NASA Glenn Research Center in June of 1999.  The 1.0
Beta version was first introduced to the U.S. aircraft
icing community in September of 1999 and has been
available to them since November of 1999.  Version 1.0
will be in production mode in February of 2000.  The
user-friendly interactive capabilities of SmaggIce will
be useful to CFD analysis as well as in experimental
model preparation and ice-shape comparison work.
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Next Phases
The remaining tasks of SmaggIce will be divided into
two phases.  In Phase 2, the code will be extended to
perform domain definition and decomposition, perime-
ter discretization, field grid generation, and grid quality
check, control, and refinement. These capabilities will
be implemented in both the interactive and automatic
modes in order to make the best attributes of each avail-
able to users when they work on difficult ice shapes. For
instance, the grid quality check, control, and refinement
can naturally be performed well interactively, while
automatic domain decomposition for an iced multi-
element airfoil can save a great deal of the user’s time
and effort. Innermost blocks for very complex ice
shapes can still be constructed interactively using Be-
zier curves as block edges. In addition, the interactive
probing features will be extended as desired by users.
Version 2 will be released at the end of Phase 2.

In Phase 3, the SmaggIce code will be closely tied to
the WIND flow solver. Users can interactively
prepare/check/submit WIND jobs, monitor their
convergence, and choose to either terminate the
iteration or return to the grid quality control process.
The whole process from iced airfoil geometry to the
aerodynamic performance prediction will be tested in
this phase using SmaggIce and Wind for a number of
iced airfoils.  At the completion of this final phase,
SmaggIce will truly make possible an interactive CFD
process for prediction of icing effects.  Version 3 will
be released at the end of Phase 3.
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Figure 1.  Steps in determining iced airfoil performance degradation: (a) ice shape acquisition
and characterization, (b) surface preparation, (c,d) definition and modification of flow domain
and grid, (e) CFD flow analysis, (f) determination of airfoil performance (i.e., lift, drag).
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Figure 2.  Probing of ice shape characteristics: location, length,  length, and angle.  The
measurements are made interactively by selecting points on the geometry and recorded in the
table.  Dark lines on the geometry indicate where measurements were made.

Figure 3.  Curve discretization and smoothing using free form modification allows
the user to change the number of control points and the number of points on the
new smoothed curve.  There is also an option to move control points around,
thereby interactively changing the shape of the curve.
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Figure 4.  SmaggIce main screen.
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Figure 5.  Data structures for multiple objects using dynamic memory.

Figure 6.  Specialized grid modification is needed for rough ice shapes to maintain smoothness,
orthogonality, and proper resolution.
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Figure 7.  Explicit local control allows modification of parts of the grid
(using control points) without affecting other parts of the grid.

Figure 8.  Block structure of flow domain around airfoil with complicated ice shapes.
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Figure 9.  Overall process of interactive icing CFD using SmaggIce and WIND.
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